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 1

I n t r o d u c t i o n

This guide introduces you to LiveLink™ for Excel®, which extends your COMSOL 
modeling environment with an interface between COMSOL Multiphysics® and 
Excel®.

In this chapter:

• About This Product

• Help and Documentation
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Abou t  Th i s  P r odu c t

LiveLink™ for Excel® extends your modeling capabilities by running COMSOL 
Multiphysics® simulations from an Excel workbook. Model definitions and results can 
easily be synchronized between your workbook and the simulation. In addition, 
LiveLink™ for Excel® adds the capability to create a COMSOL material library from 
data stored in a worksheet, and it enables support for saving and loading Excel® files 
for parameter and variable lists in the COMSOL Desktop®.

Read this section for an overview of:

• Interacting with a Model from a Worksheet

• Exporting Data to a Material Library

• Sharing a Model Between Excel® and the COMSOL Desktop®

• Loading and Saving Workbook Files in the COMSOL Desktop®

• Automating Using Visual Basic® for Application (VBA)

Interacting with a Model from a Worksheet

Figure 1-1: The COMSOL ribbon tab.

Using the tools on the COMSOL tab in the Excel® user interface (Figure 1-1) you 
can extract or modify model definitions, extract simulation results, and recompute a 
simulation. This allows you, for instance, to implement a simplified interface to a 
model (Figure 1-2) where you can access only the most important simulation 
parameters, and results from Excel.

Connecting Excel to a COMSOL Multiphysics Server is only supported 
on Windows®.
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Figure 1-2: Overview of a worksheet linked to a COMSOL model.

While you work with COMSOL models you can still interact with 3D graphics in a 
separate dedicated window. You can insert COMSOL graphics into your worksheet as 
graphics images. This makes it possible to share your workbooks with people who do 
not have access to COMSOL Multiphysics.

As soon as you open a model in Excel, a COMSOL Multiphysics Server starts in 
graphics mode where the model is loaded. The data transfer between Excel and the 
COMSOL Multiphysics Server is performed using a TCP/IP communication 
protocol.

L I N K I N G  A  W O R K B O O K  T O  A  M O D E L

When importing information from a model to a workbook in Excel, there are links 
placed in certain cells to ensure that data can be kept associated to the appropriate 
nodes in the COMSOL model. These links are represented in the Excel worksheet by 

The first time you start a COMSOL Multiphysics Server you need to 
enter a user name and password. Once this information is entered, the 
client/server communication is established. The information is stored in 
the user preferences, so that subsequent starts do not require it to be 
entered again.
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a comment on the cell, visible as a red mark at the top right cell corner. Hold the cursor 
over the cell comment to get a short description of the link.

Removing an automatically generated comment breaks the link between that cell range 
and the associated model feature.

Exporting Data to a Material Library

With LiveLink™ you can create a material library accessible by COMSOL models from 
material data stored in an Excel file. Using an interface (see Figure 1-3) you can 
configure the export such that COMSOL recognizes the material properties. The 
Material Export supports Excel sheet containing constant or field dependent material 
property.

Figure 1-3: The Material export Settings dialog box.
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Sharing a Model Between Excel® and the COMSOL Desktop®

You can share a model that is open in Excel with COMSOL Desktop by connecting 
COMSOL Desktop to the same COMSOL Multiphysics Server as Excel is connected 
to. This makes it possible to access the model settings simultaneously from Excel and 
from COMSOL desktop.

LiveLink™ for Excel® connects Excel with a COMSOL Multiphysics Server, started in 
graphics mode. This is called a graphics server. The graphics server does not support 
multiple clients connected at the same time. To share a model between the COMSOL 
Desktop and Excel you need to start a regular COMSOL Multiphysics Server when 
opening the model in Excel. See Managing Users Preferences to set the connection 
between Excel and a COMSOL Multiphysics Server without graphics.

Loading and Saving Workbook Files in the COMSOL Desktop®

LiveLink™ adds support to the COMSOL Desktop for the import and export files of 
the Excel workbook format (.xlsx). Use this functionality, for example, when saving 
data from a table to file. See Figure 1-4.

Figure 1-4: The Save to File dialog box.

Automating Using Visual Basic® for Application (VBA)

Use VBA to control the content of Excel workbooks, create user interfaces, perform 
advanced calculations on worksheet linked to a COMSOL model. Using LiveLink™ 

Loading and saving workbook files is supported on all platforms even if 
Excel is not installed.
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also offers the possibility to use the COMSOL Application Programming Interface 
(API) in order to implement a model. 

You can save the model file for VBA format directly from the COMSOL 
Desktop.
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He l p  and Do cumen t a t i o n

A number of internet resources have more information about COMSOL, including 
licensing and technical information. The electronic documentation, topic-based (or 
context-based) help, and the application libraries are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N  A N D  O N L I N E  H E L P

The COMSOL Multiphysics Reference Manual describes all core physics interfaces 
and functionality included with the COMSOL Multiphysics license. This book also has 
instructions about how to use COMSOL Multiphysics and how to access the 
electronic Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to many of the features on the GUI. To 
learn more about a node in the Model Builder, or a window on the Desktop, click to 
highlight a node or window, then press F1 to open the Help window, which then 
displays information about that feature (or click a node in the Model Builder followed 
by the Help button ( ). This is called topic-based (or context) help.

If you are reading the documentation as a PDF file on your computer, the 
blue links do not work to open an application or content referenced in a 
different guide. However, if you are using the Help system in COMSOL 
Multiphysics, these links work to other modules (as long as you have a 
license), application examples, and documentation sets.

To open the Help window:

• In the Model Builder, Application Builder, or Physics Builder click a node or 
window and then press F1. 

• On any toolbar (for example, Home, Definitions, or Geometry), hover the 
mouse over a button (for example, Add Physics or Build All) and then 
press F1.

• From the File menu, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the Help( ) 
button.
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Opening the Documentation Window

T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W

Each application includes documentation with the theoretical background and 
step-by-step instructions to create a model application. The applications are available 
in COMSOL as MPH-files that you can open for further investigation. You can use the 
step-by-step instructions and the actual applications as a template for your own 
modeling and applications. In most models, SI units are used to describe the relevant 
properties, parameters, and dimensions in most examples, but other unit systems are 
available.

Once the Application Libraries window is opened, you can search by name or browse 
under a module folder name. Click to view a summary of the application and its 
properties, including options to open it or a PDF document. 

To open the Help window:

• In the Model Builder or Physics Builder click a node or window and then 
press F1.

• On the main toolbar, click the Help ( ) button.

• From the main menu, select Help>Help.

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu select Help>Documentation ( ).

To open the Documentation window:

• Press Ctrl+F1.

• On the main toolbar, click the Documentation ( ) button.

• From the main menu, select Help>Documentation.

The Application Libraries Window in the COMSOL Multiphysics 
Reference Manual.
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Opening the Application Libraries Window
To open the Application Libraries window ( ):

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 
support@comsol.com. An automatic notification and case number is sent to you by 
email.

• From the Home toolbar, Windows menu, click ( ) Applications 

Libraries.

• From the File menu select Application Libraries.

To include the latest versions of model examples, from the File>Help 
menu, select ( ) Update COMSOL Application Library.

Select Application Libraries from the main File> or Windows> menus.

To include the latest versions of model examples, from the Help menu 
select ( ) Update COMSOL Application Library.
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W o r k i n g  W i t h  M o d e l s  F r o m  W o r k s h e e t s

Read this chapter for a description of the functionality provided by the LiveLink™ 

software inside the Excel® user interface. After installation the COMSOL 5.5 tab is 
included on the ribbon in Excel. This is where you can access, modify, solve, and 
extract results from a simulation, or where you can configure data to create a 
material library.

In this chapter:

• Overview of the COMSOL Tab

• Working With Models From Worksheets

• Exporting Material Data
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Ove r v i ew o f  t h e  COMSOL T ab

Switch to the COMSOL 5.5 tab in Excel® to access LiveLink™ functionality.

The available tools are sorted into the following groups:

• Edit, where you can insert graphics into a worksheet, edit preferences and manage 
links to a model.

• Definitions, where you can retrieve and update model definitions.

• View, where you can view the geometry and mesh.

• Study, you can compute the solution and access a parametric sweep.

• Plots, where you can display result plots.

• Numerical Results, where you can evaluate and extract data to the worksheet.

• Material Export, where you can create a material library.

• Report, where you can generate a report of the current model.

• Help, where you can access the documentation.

Edit

Use the buttons in the Edit group to access preferences, manage the link between a cell 
range and the model, and insert a plot to the worksheet.

I N S E R T  G R A P H I C S

Click Insert Graphics ( ) to import into the worksheet the current graphics display 
using the COMSOL Multiphysics Server. The image can be exported from the 
graphics or directly taken as a screenshot. You can specify how you want the image and 
its size from the Preferences window.
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B R E A K  L I N K

Click Break Link ( ) to remove the comment added by LiveLink™ from the selected 
cell range. This breaks the link between the cell range and the model.

Definitions

The Definitions group has the functionality to import model settings into the current 
worksheet, for example, parameters, variables, or functions. Select the cell range in the 
worksheet where you want to import the data, then click any of the buttons described 
below.

Importing data also creates a link between the worksheet and the model. You can edit 
the data and update the model with definitions from the modified cell.

P A R A M E T E R S

Click Parameters ( ) to import all the global parameters from the open model. 

Click Parameters>Filter ( ) to import only parameters with the prefix extern added 
to their name. This is useful if a model contains many parameters and you only want 
to import a few into the Excel workbook. If that is the case then just supply the 
parameter names you want to use from Excel with the prefix extern_.

You can modify the expression, unit, and description of a parameter in the worksheet. 
To add a new parameter, enter it below the last parameter imported from the model.

Any change to the list is transferred to the COMSOL model during the 
update operation, which is by default done automatically. To control 
manually the model update with the modifications in the worksheet, see 
Update.

If you remove the comment on a cell that contains a material name or 
property configured for material export, the material or property is not 
exported to the material library, and the settings are lost.
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V A R I A B L E S

Click Variables ( ) to import all the variables available in the open model. 

Click Variables>Filter ( ) to import only model variables with the prefix extern 
added to their name. This is useful if a model contains many variables and you only 
want to import a few into the Excel workbook. If that is the case then just supply the 
variable names you want to use from Excel with the prefix extern_.

Click Variables>Select ( ) to import only variables from a selected Variables node in 
the model. 

You can modify the expression and description of imported variables in the worksheet. 
Any change to the list is transferred to the COMSOL model during the 
update operation, which is by default done automatically. To control 
manually the model update with the modifications in the worksheet, see 
Update.

F U N C T I O N S

Click Functions ( ) to import function definitions from the open model.

You can edit in the worksheet the imported function definitions.

Any change to the list is transferred to the COMSOL model during the 
update operation, which is by default done automatically. To control 
manually the model update with the modifications in the worksheet, see 
Update.

The function import only supports one of the following type: Analytic, 
Interpolation, Step or Random.
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U P D A T E

By default the update of parameters, variables, or functions is performed automatically 
as the cell is edited. This section describes how you can update manually the model 
with the value defined in the cell.

Click Update ( ) to update the open model with definitions found in the range of 
cells including the selected cell. The update requires that there is a link to the model 
within the cell range. The model is not updated if the open model does not correspond 
to the model referenced in the link. Using this button you can update parameters, 
variables, and functions.

Click Update>Update All ( ) to update the model with all model definitions found in 
the current worksheet. Only cell ranges containing a link to a model are used for the 
update.

Click Update>Update Multiple ( ) when you want to select which parameter table to 
update with the other model definitions. found in the current worksheet. This opens 
the Update Multiple window where you can select which parameter table to update.

In the Parameters section, select the parameter table (defined in the specified cell 
range) to update the model with the definitions found in the current worksheet.

If you have imported model definition using the function and variables table you can 
select Update to update the model with the value in the worksheet.

To set manual update for the model parameters, see Managing Users 
Preferences.
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View

Using the buttons in the View group you can display the model geometry or mesh in 
the graphics COMSOL Multiphysics Server window.

G E O M E T R Y

Click Geometry ( ) to display the model geometry in the graphics COMSOL 
Multiphysics Server window. In case the model contains multiple geometry nodes you 
can select the geometry to view from the menu. To change the level of detail for the 
displayed geometry see Managing Users Preferences.

M E S H

Click Mesh ( ) to display the mesh in the graphics COMSOL Multiphysics Server 
window. In case the model file contains multiple mesh nodes you can select the mesh 
node to view from the menu.

Study

The Study group provides access to parametric sweep settings, and allows you to 
compute the solution for a selected study from the model.

C O M P U T E

Click Compute ( ) to solve the model linked with the current workbook. The first 
study node in the model is computed by default.
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S W E E P

Click Sweep ( ) to open the Sweep dialog box where you can view and edit the 
parametric sweep settings in the model.

From the Study list select the study to use. The list contains all sweep parameters 
defined in the model, including Auxiliary sweep.

The table lists the sweep parameters and the values. Edit the Parameter value list 
column to modify the sweep interval.

Click Export to export the parameter names values to the spreadsheet at the selected 
cell. The export also creates a link between the worksheet and the table in the Sweep 
window.

Click Update to update the model with parameters and values defined in the table. The 
table is automatically updated with the values from the worksheet when the cell range 
containing the sweep comment is selected.

Click Close to close the Sweep dialog box.

S T U D Y

Click Study ( ) then select a study node from the model for computation. Selecting 
the study computes the solution.

Plots

In the Plots group you access the plot settings, and display a selected plot group in the 
graphics COMSOL Multiphysics Server window.
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P L O T S  G R O U P S

Click Plot Groups ( ) and select a plot group from the menu to view it in the graphics 
COMSOL Multiphysics Server window. You cannot create new plots, only plot groups 
that are defined in the open model can be viewed.

P L O T  S E T T I N G S

To specify the parameter value, time, or eigenfrequency for which to display results for 
in the current plot group click Plot Settings ( ).

Numerical Results

With the tools in the Numerical Results group you can evaluate expressions and insert 
the evaluation results from a model table to the worksheet. In order to extract a 
numerical results first select an empty cell in the worksheet where to export the data in 
the worksheet.

P A R A M E T E R S

Click Parameters ( ) to insert result parameters in the worksheet. Result parameters 
can be used for calculating results without having to update or solve the model in 
contrast to parameters available in the Definitions section.

D E R I V E D  V A L U E S

Click Derived Values ( ) to open the Derived Values dialog box where you can select 
an expression to import to the worksheet. 
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Expressions need to be defined under the Derived Values node of the model to be 
available in the list.

P O I N T  E V A L U A T I O N

Click Point Evaluation ( ) to open the Point Evaluation dialog box.

In the Point Evaluation window select the Data set to evaluate on, and specify the points 
where the expression should be evaluated. Enter a valid expression into the Expression 
text field, then click OK for perform the evaluation. The results are inserted at the 
selected cell in the worksheet.

I N T E R P O L A T I O N

Click the Interpolation button ( ) to open the window with the same name.

From the Data set list, choose the solution data set from the model. For solution data 
set of type parametric, also select the parameter value from the Parameter list. In the 
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Expression text field enter the expression to evaluate. Finally, to enter the cell range that 
contains the coordinates for the interpolation points in the Coordinates from cell range 
text field, click the Select range button ( ). Click OK to evaluate and insert the results 
into the worksheet.

Format the point coordinate data on the worksheet such that the coordinates are listed 
in columns, with each row defining an evaluation point as in the figure below:

Select Include Header if you want to include automatic header with the evaluated data. 
In this case the data are shifted one row down and a header is included at the location 
of the cell comment.

P A R T I C L E  E V A L U A T I O N

Under Ray and Particle click Particle Evaluation ( ) to open the Particles dialog box 
where you can evaluate expressions along particle trajectories.

The particle evaluation requires a license for the Particle Tracing Module.
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Select a particle data set from the Data set list. From the Evaluate section select any of 
the following options:

• Position, to include in the evaluation the particle position along the trajectories.

• Velocity, to include in the evaluation the particle velocity along the trajectories.

• Expression, to include in the evaluation along particle trajectories the expression you 
specify.

Reduce the evaluation output by entering the number of particles for the evaluation in 
the Number of particle text field. Click OK to perform the evaluation and to insert the 
results into the worksheet.

R A Y  E V A L U A T I O N

Under Ray and Particle click Ray Evaluation ( ) to open the Rays dialog box where 
you can evaluate expressions along ray trajectories.

The ray evaluation requires a license for the Ray Tracing Module.
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Select a ray data set from the Data set list. From the Evaluate section select any of the 
following options:

• Position, to include in the evaluation the ray position along the trajectories.

• Velocity, to include in the evaluation the ray velocity along the trajectories.

• Expression, to include in the evaluation along ray trajectories the expression you 
specify.

Reduce the evaluation output by entering the number of rays for the evaluation in the 
Number of rays text field. Click OK to perform the evaluation and to insert the results 
into the worksheet.

T A B L E S

Click Tables ( ) to open the Tables dialog box and to select a table available from the 
model. Click OK to export the table data at the selected cell range.
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1 D  P L O T  E X P O R T

Excel does not have a chart type that support general 2D- and 3D-plots that are 
commonly produced in COMSOL. However, 1D-plots have data that can be extracted 
to Excel and Excel can create plots of these data as well.

First select the cell in worksheet where you want to import the plot data. 

Then click 1D Plot Export ( ) and select from one of the 1D plots that are defined in 
the model to open the 1D Plot Export dialog box. In this dialog box you set what to 
import into Excel:.

The Plots list contains all the plots defined under the plotgroup, by default all plot are 
imported but you can also select manually which plot to import.

While importing the data the plot is automatically generated in Excel and placed beside 
the imported data. Clear Create plot in Excel to not generate automatically the plot. 

You can specify manually the plot position ion Excel, select one from the option Left, 
Right, Top, Bottom to place the chart beside the data. Select Custom to specify the cell 
where to place the top left corner of the chart.

U P D A T E

Click Update ( ) to update all data evaluations on current worksheet. Only cell 
ranges containing a valid link to the model are updated.

C L E A R  A N D  E V A L U A T E  A L L

Click Clear and Evaluate All ( ) to clear all imported table entries and then evaluate 
all derived values.
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Material Export

Use the Material Export group to export data from a worksheet to a material library.

Click Settings ( ) to open the Material Export window where you can configure the 
export. For details see Exporting Material Data.

After you configure the data click New ( ) to create a new material library or click 
Append ( ) to add the material definitions to an existing library.

Click batch ( ) to open the Material Export Batch window where you can configure 
the batch export. For details see Exporting the Material Library in Batch.

Report

Use the Report group to generate a report using the current model and write it in a 
given format.

Under Report ( ), select the type of report you want to generate, it can be either 
brief, intermediate or complete depending the level of details you want.  

You can also create a report based on user defined template available in the model.

When generating a new report in the model you are asked to enter the report node 
label in the Generate Report window.

Under Regenerate you select an already existing reports in the model to update with 
the current model settings.

Description of the built-in report types is in Reports in the COMSOL 
Multiphysics Reference Manual.
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Click Write to open the Write Report windows where you can set the file and image 
format of the report.

In the Report section select which report to write. The settings in the window are 
automatically updated from the selected report properties.

In the Format section you can choose between HTML and Microsoft Word® (.docx) 
format as output format.

In the Filename edit field enter the name of the report file. You can also browse to a 
folder to specify where to save the file. If no path is defined in the filename, the model 
path is used.

Select Open finished report if you want to visualize the report just after being generated.

You can choose between default and customized Style sheet in the corresponding 
menu list. When using custom style sheet, browse to the style sheet file, in the .css 
format, to use.

In the Images section you specify the images format to be included in the report. You 
can choose between five size from Extra small to Extra large, the default image size is 
set to Medium. In the Type menu you specify the image format to generate, you can 
choose between PNG, JPEG or BMP.
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Help

Click Documentation ( ) to open a browser with the COMSOL Multiphysics 
documentation.

Click Help ( ) to access the LiveLink™ for Excel® User’s Guide.
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Work i n g  W i t h  Mode l s  F r om 
Work s h e e t s

In this section:

• Accessing the Model Definitions

• Computing the Solution

• Running a Model in Sweep

• Evaluating the Results

• Displaying the Results

• Updating Data in Cells Linked to the Model

Accessing the Model Definitions

LiveLink™ has the functionality to import model definitions to a worksheet, for 
example, parameters, variables, and functions. You find the related tools grouped 
under Definitions on the COMSOL tab in the Excel® user interface.

P A R A M E T E R S

To import all global parameters select a cell in the worksheet and click the Parameters 
button. The parameters are inserted to the right and down from the selected cell. A 
link to the model, represented by a comment inserted in the selected cell, ensures that 
you can update the model with changes to the parameters in the worksheet. The 
imported data is formated as in Figure 2-1, with the parameter definitions organized 
into six columns.

Figure 2-1: Model parameters after import to a worksheet.

The value column is automatically updated with the expressions you may enter. You 
can change this behavior in the Users Preferences window, see Managing Users 
Preferences.

The first Unit column is the unit to append to the expression, while the second Unit 
column is the unit for the parameter evaluation. You can change the formatting to 
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include the parameter unit together its expression in the users preferences, see 
Managing Users Preferences.

Figure 2-2: Model parameters after import to a worksheet without the unit column.

Parameters>Filter, to import only parameters with name containing the prefix 
extern_.

Figure 2-3: Model parameters after filtered import to a worksheet.

V A R I A B L E S

To import all model variables, select a cell in the worksheet and click the Variables 
button. Variables are inserted to the right and down from the selected cell. A link to 
the COMSOL model, represented by a comment inserted in the selected cell, ensures 
that the model can be updated with changes to the variables in the worksheet. After 
the import, the variable definitions are formatted as in Figure 2-4.

Figure 2-4: Model variables inserted into a worksheet.

Variables>Filter, to import only variables with names containing the prefix extern_.

Variables>Select, to import all the variables from the selected feature node only.

You can edit imported variables in your worksheet. To update the model with the 
modified definitions, see Updating Data in Cells Linked to the Model. 

F U N C T I O N S

To import function definitions from the model, select a cell in the worksheet and click 
the Functions button. The Functions dialog box opens, allowing you to select analytic 
or interpolation functions in the model. The imported data is inserted to the right and 
down from the selected cell. A link to the COMSOL model, represented by a comment 
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inserted in the selected cell, ensures that the model can be updated with changes to the 
function in the worksheet. 

For an analytic function the data is imported into two columns as in Figure 2-5.

Figure 2-5: Analytic function table format after import.

For an interpolation function the data is formatted as in Figure 2-6.

Figure 2-6: Interpolation function table format after import.

You can edit imported model functions in your worksheet. To update the model with 
the modified definitions, see Updating Data in Cells Linked to the Model. 

Computing the Solution

To solve the model directly from the Excel user interface, click the Compute 
button ( ) from the Study group. Note that if the model contains several studies 
only the first study is computed. In this case you can also click the Study button ( ), 
and from the menu select the study to compute.

Running a Model in Sweep

This section describes how to run a model in sweep using data value from the 
worksheet.

T H E  S W E E P  D I A L O G  B O X

To access the sweep parameter value list, select Sweep ( ) to open the Sweep dialog 
box.

You have limited access to the solver settings from the COMSOL tab. It is 
recommended that you make sure that the model is suitably configured 
in the COMSOL Desktop before opening it in Excel.
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If you plan to link cell ranges in the worksheet and the parameter list in the model, 
before you open the Sweep dialog box, first select the cell where the link is to be 
included.

The Sweep dialog box contains the list of the parameter name and value set in the 
parametric sweep node and in the auxiliary sweep settings available in the selected 
study.

In the Study list you can select the study where to define the parameter sweep value.

The Parameter names column lists the model parameters defined to run in sweep. The 
Parameter value list column contains the associated value. The Range column lists the 
cell range in the worksheet linked to the model parameters. You can directly edit the 
Parameter value list column. Click Update to update the modification in the model. 

L I N K I N G  P A R A M E T E R  S W E E P  V A L U E S  W I T H  T H E  W O R K S H E E T

In the Sweep dialog box click Export to export the parameter sweep value list to the 
current worksheet. As part of the export, a link is created between the worksheet and 
the model. This is represented by a cell comment. In the worksheet, the parameter 
sweeps are stored in line from the cell containing the comment, the first column 
including the parameter names.

If the parameter value list only contains data separated by a space or a comma, the data 
are inserted in separate cells. If the parameter value list contains a string, such as a range 
function, or includes units, the data are exported to one unique cell.
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After the export the Range column includes the cell range defining all the sweep 
parameter value list in the worksheet.Note that a cell comment is also created for each 
parameter name allowing specific update if necessary. 

You can now edit the parameter value linked with the selected cell comment in the 
worksheet. Then close the Sweep dialog box. The parameter value has to be defined in 
the cells beside the one containing the parameter name.

U P D A T I N G  T H E  P A R A M E T E R  V A L U E  L I S T  T O  T H E  M O D E L

If the worksheet contains a link between a range and a parameter sweep list, select the 
cell with the comment and select Sweep ( ). The Parameter value list and the Range 
columns are automatically updated with the value from the worksheet. Click Update to 
update the model with the value defined in the worksheet.

To update the model with the modified parameter value list, you need to select the cell 
with the comment and select Sweep ( ). The parameter value list now contains the 
value from the worksheet. Click Update to update the model with the value defined in 
the worksheet.

Evaluating the Results

With LiveLink™ for Excel® you can evaluate and insert simulation results into a 
worksheet. The tools needed for this are grouped under Numerical Results on the 
COMSOL tab in the Excel user interface. To perform the evaluations at least one solution 
data set needs to be present in the model.

It is not necessary to have links between the worksheet and the model to 
modify the sweep parameter value list, you can edit the value in the Sweep 
dialog box and click Update.
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D E R I V E D  V A L U E S

To evaluate data found in the Derived Value nodes defined in the model select the cell 
in the worksheet then click the Derived Values ( ) button.

In the Derived Values dialog box, specify from which derived values node to import the 
data and click OK. The evaluated data is inserted to the right and down from the 
selected cell. A link to the model, represented by a comment inserted in the selected 
cell, assures that the evaluation can be updated with changes to the model solution.

P O I N T  E V A L U A T I O N

To evaluate expressions on specified geometry vertices select a cell in the worksheet 
and click the Point Evaluation ( ) button. In the Point Evaluation dialog box, select 
the solution data set, one or more points, and specify the expression to evaluate. Click 
OK to import the data. The evaluated data is inserted to the right and down from the 
selected cell. A link to the model, represented by a comment inserted in the selected 
cell, assures that the point evaluation can be updated with changes to the model 
solution.
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I N T E R P O L A T I O N

To evaluate expressions at arbitrary location select a cell in the worksheet, click 
Interpolation  to open the Interpolation dialog box. 

Select the solution data set, if a parametric solution data set specify the parameter value. 
Enter the expression to evaluate, and the cell range that contains the point coordinates 
for the evaluation. The coordinates need to be formated so there is one point per row, 
with the coordinates in different columns. The number of evaluation points 
correspond to the number of rows.

The evaluated data is inserted to the right and down from the selected cell. A link to 
the model, represented by a comment inserted in the selected cell, assures that the 
point evaluation can be updated with changes to the model solution.
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P A R T I C L E  E V A L U A T I O N

To evaluate expressions along particle trajectories, first select a cell in the worksheet 
then, under Ray and Particle, click the Particles ( ) button.

In the Particles dialog box, select a valid particle tracing solution data set. Then specify 
the time for data evaluation in the Time list. Under Evaluate section you select what 
to extract in the worksheet: the position, the velocity and a specified expression. Finally 
you can define the number of particles for which you want to perform the evaluation. 
The amount of particles in the particle data set is available in the Info field, under the 
Data set menu list.

The evaluated data is inserted to the right and down from the selected cell. A link to 
the model, represented by a comment inserted in the selected cell, ensures that the 
point evaluation can be updated with changes to the model solution.
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R A Y  E V A L U A T I O N

To evaluate expressions along ray trajectories, first select a cell in the worksheet then, 
under Ray and Particle, click the Rays ( ) button.

In the Rays dialog box, select a valid ray tracing solution data set. Then specify the time 
for data evaluation in the Time list. Under Evaluate section you select what to extract 
in the worksheet: the position, the velocity and a specified expression. Finally you can 
define the number of rays for which you want to perform the evaluation. The amount 
of rays in the ray data set is available in the Info field, under the Data set menu list.

The evaluated data is inserted to the right and down from the selected cell. A link to 
the model, represented by a comment inserted in the selected cell, ensures that the 
point evaluation can be updated with changes to the model solution.

T A B L E S

To extract data from tables defined in the model select a cell in the worksheet, click the 
Tables ( ) button and from the dialog box select the table to insert into the 
worksheet. The size of selected table is display below the Table name menu list. The 
evaluated data is inserted to the right and down from the selected cell. A link to the 



42 |  C H A P T E R  2 :  W O R K I N G  W I T H  M O D E L S  F R O M  W O R K S H E E T S

model, represented by a comment inserted in the selected cell, ensures that the point 
evaluation can be updated with changes to the model solution.

M O D I F Y  T H E  E V A L U A T I O N  S E T T I N G S

You can modify the settings for an existing data evaluation by following these steps:

• From a cell range containing evaluation results, select the cell that contains the link 
to the model.

• Click the button corresponding to the evaluation operation.

• Edit the settings for the evaluation.

• Click OK to perform the evaluation and replace the data in the cell range.

To update the existing evaluations after recomputing a solution, see Updating Data in 
Cells Linked to the Model.

Displaying the Results

To select a plot group to display in the graphics COMSOL Multiphysics Server 
window, click the Plot Group button ( ) and from the menu list select an available 
plot group from the model.

If the plot group uses a solution data set containing multiple solution parameters, you 
can specify the parameter you would like to view in the Plot Settings dialog box 
accessible by clicking the Plot Settings button ( ).

I M P O R T I N G  G R A P H I C S

To import the current view of the graphics COMSOL Multiphysics Server window, 
click the Insert Graphics button ( ) on the Edit group. The inserted graphics can 
either be a screenshot of the current graphics window or an export of the current plot. 
You can specify how to import the image and its size in the Preferences dialog box 
available from the Edit group.

Graphics display are enable with graphics server only, see Managing Users 
Preferences to enable graphics server.
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Updating Data in Cells Linked to the Model

U P D A T I N G  M O D E L S  D E F I N I T I O N S

You can edit imported model definitions in the worksheet. The cell comment 
maintains the link between the data in the worksheet and the model, so that you can 
update the model with the new data.

To perform an update select the cell with the comment and click the Update button 
( ).

To update all model definitions in a worksheet, click the Update all button ( ). The 
Update all button is accessible in the menu under the Update button.

If you have multiple table that defines model definitions, click Update multiple button 
( ) to specify which tables to use during the update in a separate dialog box. 

In the Update Multiple dialog box you can select the parameter table defined with the 
cell range. You can also update model definitions with imported the variables and 
functions tables.

To solve the model after the update see Computing the Solution.

U P D A T I N G  S W E E P  P A R A M E T E R  V A L U E  L I S T

First select the cell with the comment representing the link to the sweep node in the 
model. In the Study group, click the Sweep button ( ). Select Update to update the 
parametric sweep node with the one stored in the worksheet.

Imported parameters are updated automatically, see Managing Users 
Preferences to disable automatic update.
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U P D A T I N G  N U M E R I C A L  R E S U L T S

In the Numerical Results group, click the Update button ( ) to update all results data 
found in a worksheet.

Click Parameters button ( ) to import results parameters from the model. These 
parameters allow you to update results analysis and postprocessing without 
recomputing the solution. Once you have edited the parameters in the worksheet, click 
the Update button ( ).

T H E  C E L L  C O M M E N T

For model definitions and numerical results imported into the worksheet the 
LiveLink™ for Excel® interface adds a comment to the cell selected at the time of the 
import. This cell comment is a link to the model ensuring that the data can be updated. 
The comment can also contain the evaluation settings to allow subsequent editing of 
the evaluation operation. Click Break Link ( ) to remove a comment from a cell. 

The data in the cell range cannot be updated if the comment is missing.
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Th e  COMSOL Ba c k s t a g e  V i ew

Functionalities such as managing model MPH-file, connection with a COMSOL 
server, running COMSOL Apps and settings users preferences are grouped in the 
COMSOL backstage view. To access the COMSOL backstage view go to the Excel File 
menu and click COMSOL.

In this section:

• Opening a Model MPH-File

• Saving a Model MPH-File

• Connecting Excel® to a COMSOL Server

• Disconnecting Excel® from a COMSOL Server

• Managing Model Loaded on a COMSOL Server

• Connecting the COMSOL Desktop® with the COMSOL Multiphysics Server

• Run Application

The term COMSOL server designates either a COMSOL Multiphysics 
Server or COMSOL Server™ for running applications.
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• Managing Users Preferences

Opening a Model MPH-File

To extract model definitions or results to an Excel® worksheet you need to link the 
workbook with a model loaded in a COMSOL server. You can directly open the model 
from Excel. If it is not already running, this starts a COMSOL Multiphysics Server in 
the background where the model is loaded. You can open any new model mph-file or 
open a model already linked in the workbook.

O P E N I N G  A  N E W  M O D E L

Under the File Excel ribbon tab click COMSOL to access the COMSOL Backstage view.

Click Open ( ), then find the model MPH-file and click OK.

The model geometry, or a result plot when one is available in the model file, is 
displayed in an external graphics window. In Excel, the model name is inserted into the 
worksheet, see Figure 2-7. 

Figure 2-7: Spreadsheet after model import.

The model description and image, if contained in the model file, are also inserted. In 
addition, a comment is added to the cell selected before loading the model with the 
text COMSOL Model. This comment is used by LiveLink™ interface to maintain the 
connection between the worksheet and the model on the COMSOL Multiphysics 
Server.

The comment is automatically updated if you save the model under a different name. 
Removing the comment breaks the link between the workbook and the model.

O P E N I N G  A  L I N K E D  M O D E L  I N  T H E  W O R K S H E E T

If the worksheet already contains a cell link with a model path you can open directly 
open the associated model. Under the File Excel ribbon tab click COMSOL to access the 
COMSOL Backstage view. Click Open linked ( ), this will open the file with the path 
defined in the cell comment link.

Only one model can be opened per workbook. Opening another model 
updates the link to point to the last opened model.
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O P E N I N G  A  M O D E L  C O N T A I N I N G  U S E R  D E F I N E D  P H Y S I C S  I N T E R F A C E

If the model contains a user defined physics interface created using the COMSOL 
Physics Builder, you need to save the compiled archive (.jar) in your user home folder 
.comsol/v55/archives. Any compressed archive (with extension .jar) is loaded 
next time the COMSOL Multiphysics Server starts.

O P E N I N G  A  M O D E L  W I T H  A  C L A S S  K I T  L I C E N S E

For Class Kit License (CKL) type, you need to tart the COMSOL Multiphysics Server 
with the Classkit License, see the Managing Users Preferences to start the server with 
Classkit License.

Saving a Model MPH-File

Click Save ( ) to save the currently open model on the COMSOL Multiphysics 
Server. The model is saved in the MPH-file format. Then the link between the 
spreadsheet and the model is updated automatically.

• Click Save As ( ) to save the currently open model file using a new name. The 
model is saved in the MPH-file format.hen the link between the spreadsheet and the 
model is updated automatically.

Connecting Excel® to a COMSOL Server

The default settings using LiveLink™ for Excel® consist of starting a new COMSOL 
Multiphysics Server on the local machine the first time a model is loaded from the 
spreadsheet. You can specify a running COMSOL server to connect with Excel.

To specify the COMSOL server to be connected to Excel:

1 Start Excel and separately start a COMSOL server.

2 In Excel, go to File ribbon tab and select COMSOL.

Saving the Excel workbook does not automatically save the linked model. 
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3 In the COMSOL Backstage go to Server and click Connect ( ) .The Connect to 
Server then pops-up.

4 In the Server text field enter the COMSOL server name (or server IP address). Enter 
localhost if the COMSOL server and Excel are running on the same machine.

5 In the Port menu list select manual if the COMSOL server is not listening to the 
default port number (2036). The port number is the one displayed in the COMSOL 
server window.

6 In the User and Password text field enter the login information requested by the 
COMSOL server.

7 Click OK.

Disconnecting Excel® from a COMSOL Server

To disconnect Excel from a running COMSOL server, go to the File menu and select 
COMSOL. In the COMSOL backstage view click Disconnect ( ).

Managing Model Loaded on a COMSOL Server

It is possible to import model that is loaded on a COMSOL server and to delete such 
models.

When connecting Excel with a COMSOL Multiphysics Server not using 
graphics, you need to connect the server with a COMSOL Desktop to 
display graphics of the current model. See Connecting the COMSOL 
Desktop® with the COMSOL Multiphysics Server.
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L O A D  M O D E L  F R O M  S E R V E R

To load a model that is already loaded on a COMSOL server go to the Excel File menu 
and click COMSOL. In the COMSOL backstage view click Server ( )and then 
Load Model ( ). 

In the Import Application from Server dialog box select in the list the application you 
want to open in the workbook and click OK.

U N L O A D  M O D E L  F R O M  S E R V E R

To remove a model from a COMSOL server go to the Excel File menu and click 
COMSOL. In the COMSOL backstage view click Server ( )and then 
Unload Models ( ).

In the Remove Application from Server dialog box select in the list the application you 
want to remove from the COMSOL server.

Connecting the COMSOL Desktop® with the COMSOL Multiphysics 
Server

This section describes how to manually connect a COMSOL Desktop with a model 
open in Excel®. The COMSOL Multiphysics Server without graphics allows multiple 
clients connection, for example, Excel and a COMSOL Desktop. By default Excel 
starts a COMSOL Multiphysics Server using graphics mode when opening a model. 
This server does not support multiple client connections. See Managing Users 
Preferences to use a COMSOL Multiphysics Server without graphics.
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To display the model open from Excel in a COMSOL Desktop:

1 Start Excel and load a model in Excel as indicated in Opening a Model MPH-File.

2 In the COMSOL Desktop, from File menu (Windows users) or from the Options 
menu (Mac and Linux users), select Client Server>Connect to Server ( ).

You can now access the same application from both Excel and the COMSOL Desktop. 
Every change operated from Excel can be visualized from the COMSOL Desktop once 
the model is updated.

If you have already open an application in Excel and you want to open it also in the 
COMSOL Desktop, select COMSOL Multiphysics Server>Import Application from 

Server ( ) from the File menu (Windows users) or from the Options menu (Mac and 
Linux users). In the Import Application from Server window select the model to import.

If you want to open an application loaded in the COMSOL server in Excel, click the 
arrow beside the Connect to Server button and select Import Application from 

Server ( ) .

Run Application

From Excel® you can launch apps created using the COMSOL Applications Builder, 
go to the File menu and select COMSOL. In the COMSOL backstage view under 
Applications ( ), click Run Application ( ). Then browse to the MPH-file of the 
application to run and click Open.

You can also run apps that are loaded in the COMSOL Server. To open the COMSOL 
Server™ web interface from Excel, go to the File menu and select COMSOL. In the 
COMSOL backstage view under Applications ( ), click COMSOL Server( ). Finally 
enter the credential to connect to the server.
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Managing Users Preferences

Go to the File ribbon tab and click COMSOL to open the COMSOL Backstage view. 
Click Preferences ( ) to open the Preferences dialog box.

Under Data formatting, select Format headers to create column or row headers with 
bold fonts. Frame regions adds a frame around the inserted data. Select the Auto adjust 

column width check box to automatically adjust cell width to fit the imported data.

Under Parameters, clear the Split value from unit when loading parameters check box if 
you want the value and unit of parameters to be inserted together as a string into a 
single cell. By default the check box is selected so that the parameter values are 
formatted as numbers, and the parameter units are imported into a separate cell. Clear 
Automatic update if you don’t want the parameters imported in Excel to have their 
values updated on the fly before computing the solution.
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Under Graphics, select Show model thumbnail if you want the model image to be 
inserted into the worksheet when a model is loaded. In the list box Geometry detail you 
can change the level of detail for geometry displayed in the graphics COMSOL 
Multiphysics Server window. Select Snapshot radio button to insert the graphics as it 
looks like in the graphics window (including background image). Select Export radio 
button to insert the graphics without background image. Use the Graphics scale slider 
to change the size of the image to be inserted into the worksheet, see Insert Graphics. 

Under Progress bar, select Show progress to display an external progress bar. The 
progress bar is shown when plotting the geometry or the mesh and when computing 
the solution.

Under Language select Set language manually radio button to manually define the 
Display and Screen Tip language, choose the language in the list box. Select Use 

detected language to use the language set in Excel.

Under Server, clear Use a graphics server if you want Excel® to not connect with a 
graphics COMSOL Multiphysics Server. A server in graphics mode displays the 
geometry, the mesh or plots in external graphics window. Only a server without 
graphics mode supports the connection of a COMSOL Desktop together with Excel 
via a model.

Select Class kit license to connect Excel to a COMSOL Multiphysics Server that is 
running using a class kit license type.

You need to restart the COMSOL Multiphysics Server to enable the 
changes.
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Expo r t i n g  Ma t e r i a l  Da t a

To export material properties from a workbook in the Excel user interface to a 
COMSOL material library, use the tools from the Material Export group of the COMSOL 
tab. 

LiveLink™ for Excel® supports both material properties stored in the spreadsheet as 
constant or as field dependent variables (as such as temperature dependent properties, 
B-H curve, and so forth). Depending on the original format, you have to specify the 
export settings in different windows.

Automatically export the data to a new COMSOL material library or to an existing 
one. Perform the export for a single worksheet or in batch operations if the data are 
stored in different workbooks.

The Material Export Settings Window

Click Settings ( ) in the Material group to open the Material Export. Specify the 
material and the properties to export to a COMSOL material library format. The 
material export procedure depends on the data format in the worksheet; the data can 
be defined as constant or as field variables.

E X P O R T  M A T E R I A L  F R O M  D A T A  S T O R E D  A S  C O N S T A N T

In the Field dependent data tab, specify the data format in the worksheet. If the 
worksheet contains only constant data formats, make sure that Sheet contains field 

dependent data check box is not selected.
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In the Material properties tab, specify the material and the properties to be included in 
the export. 

In Material names range select the cell range that contains the material names. The 
material names have to be stored in a column in the worksheet.

In Property names range select the cell range that contains the property names. The 
property names have to be stored in a row in the worksheet.

In the Material property settings section you assign properties recognized by COMSOL 
to the properties in the worksheet. Select a property name from the Name column, then 
select a property from the Valid properties (SI Units) list.

Click Assign to assign the selected valid property to the select name from the current 
worksheet.

In the Filter edit field you can enter a text that is used to filter the valid properties list, 
for instance ‘thermal conductivity’ or ‘sigma’ in order to access the thermal 
conductivity or the electrical conductivity, respectively.

In the Unit column specify the unit in which the data is defined for the property. The 
default is SI units for all material properties.
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Under the Instructions section in the dialog box you can follow the number of 
unassigned material properties for the selection. When you have completed the 
configuration all steps are marked with the icon . If you have unassigned properties 
they will be indicated using the icon .

Click OK to save the settings and to close the window.

E X P O R T  M A T E R I A L  P R O P E R T I E S  F R O M  F I E L D  D E P E N D E N T  D A T A

In the Field dependent data tab select the Sheet contains field dependent data check box 
to specify the field variable settings.

In Field variable name range enter the cell number that contains the name of the field 
variable. The default data selection includes all data below the selected cell. You can 
manually specify the data cell range later in the Material Properties tab.

Once the field variable name is selected in the worksheet, in Assigned model input list 
select the model input in the COMSOL model that corresponds to the selected field 
variable name in the worksheet. The field dependent data is always stored in a single 
column. The field dependent data can correspond to the norm of the model input, for 
instance with the following model input: the current density, the electric field, the 
magnetic field, the magnetic flux density, the stress tensor, and the velocity field.

In the Unit field enter the unit used in the worksheet if it differs from the default 
settings.

When you have completed the configuration all steps under the Instructions section are 
marked with the icon .
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In the Material properties tab specify the material and the properties to be included in 
the export. 

In Material names range select the cell range that contains the material names. The 
material names have to be stored in a column in the worksheet.

In Property names range select the cell range that contains the property names. The 
property names have to be stored in a row in the worksheet.

In the Material property settings section assign properties recognized by COMSOL to 
the properties in the worksheet. Select a property name from the Name column, then 
select a property from the Valid properties (SI Units) list.

Click Assign to assign the selected valid property to the select name from the current 
worksheet.

In the Filter edit field you can enter a text that is used to filter the valid properties list, 
for instance ‘thermal conductivity’ or ‘sigma’ in order to access the thermal 
conductivity or the electrical conductivity, respectively.

In the Unit column specify the unit in which the data is defined for the property. The 
default is SI units for all material properties.
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In the Constant column, select the radio button for the property you want to export as 
constant. If you select constant the value in the selected cell range in Property name 
value is used as property data to export in the material library.

In the Range column, enter the property data cell range to export. For constant data 
export select a unique cell. For field dependent data export specify the list of the data 
cell to export. The cell range has to be a unique column.

Under the Instructions section in the dialog box you can follow the number of 
unassigned material properties for the selection. When the configuration is completed, 
all steps are marked with the icon .

Click OK to save the settings and close the window.

The Cell Comment

After you have configured the material data export according to the previous section 
the settings are stored in comments added to the cells that contain the material names 
and material property names. These comments enable you to edit the settings later, 
and you can also easily copy the comments to another worksheet with similar data to 
skip the steps of configuring the material export again. Do not remove the comments 
from the cells unless you want to prevent a certain material or property from being 
exported to the material library.

Saving the Material Library

In the Material Export group select Create ( ) to export the material properties to a 
new material library. In the Save Material Library window specify the filename and 
location. Click OK to export.

In the Material Export group select Append ( ) to export the material properties to 
an existing material library. In the Append Material Library window select an existing 
material library, and click OK to export.

COMSOL automatically finds and imports material libraries saved in the 
materials folder of the COMSOL preferences directory. This is set as the 
default location when you create new material libraries or when you 
append data to existing material libraries.
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Exporting the Material Library in Batch

In the Material Export group select Batch ( ) to open the Material Export - Batch.

In the Template section you find the settings defined for the material export. The 
Properties table lists the material, the property name and the cell range to export. Select 
Use value from template if the property is only defined in the template worksheet but 
should be included in all material during the batch export.

In the Source section define the worksheet to use during the export. First, in the 
Directory text field enter the path of the directory that contains the source Excel files. 
Select Include subdirectories to include workbooks stored under the main directory. 
Click Update to list the files to be used during the batch export. If you need to open 
one of the listed files, select the file in the list and click Open.

In the Output section you define where to export the material data. Select New to 
export the material data in a new material library. Select Append to export the material 
data to an existing material library.
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L o a d i n g  a n d  S a v i n g  W o r k b o o k  F i l e s

LiveLink™ adds the Excel® workbook (.xlsx) format to the list of formats for 
loading and saving model definitions from the COMSOL Desktop®. Note that it 
is not required to have Excel installed on the machine where the COMSOL is 
running. If you are using Windows and have a supported version of Excel installed 
you will have some extra features that are not provided otherwise. Read this chapter 
for a description of how to load and save tabular data to a workbook.

In this chapter:

• Importing and Exporting Model Definitions
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Impo r t i n g  and Expo r t i n g  Mode l  
De f i n i t i o n s

In this section:

• Support for Excel® Files

• Importing Data from a Workbook

• Exporting Data to a Workbook

• Supported Formats

Support for Excel® Files

The following model features support the saving or loading of Excel® files: 
Parameters, Variables, Interpolation, Piecewise, and the study step including 
continuation parameters.

Importing Data from a Workbook

To load data from a worksheet to a table in the Settings window of a feature, click the 
Load from File button ( ) below the table. In the file type list select Microsoft Excel 

Workbook (*.xlsx). Select the desired file and click Open. Specify the sheet and cell range 
for the data. 

In the Sheet text field enter the name of the worksheet containing the data. If no sheet 
name is defined, the first worksheet in the Excel file is selected by default.

Loading data from workbook files in a COMSOL Multiphysics model is 
also supported when Excel is not available.
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In the Range field enter the cell range that holds the data. The range can be either 
defined using:

• the top left cell number, to import all data up to the next empty cell.

• the cell range, to specify which cells are used for the import.

• empty cell range, to import the entire worksheet.

Also see Supported Formats.

Clear the Overwrite check box to append the imported data to the end of the table. 
Note that you need to resolve conflicting data after the import.

For parameters import select Separate units column if the worksheet contains the 
parameter values and units in separate but adjacent columns.

Click Load to load the data to the table. Excel automatically starts in the background, 
if available. Excel will close after the import has been performed.

Exporting Data to a Workbook

In the Settings window of the feature click the Save to File button ( ), usually located 
below the table. From the Save as type list select Microsoft Excel Workbook (*.xlsx), then 
specify the desired filename and click Save. Specify the sheet and cell range for the data 
export.

Excel usually locks the file when open it and hence the file cannot be 
loaded by other applications. Use Excel for reading the file to avoid this 
limitation.

Saving data to workbook files from a COMSOL model is also supported 
when Excel is not available.
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In the Sheet text field enter the worksheet name where to store the data. If no sheet 
name is defined, the first worksheet of the Excel workbook is selected by default.

In the Range field enter the cell range where data should be written. The range can be 
either defined using:

• a unique cell number defining the top cell in the worksheet.

• a cell range, to specify the cell where to save the data. Only the data within the 
specified cell range are exported.

• an empty cell range, all the data are saved starting from the cell A1.

Also see Supported Formats.

Clear the Overwrite check box if you want to append the data to the Excel file. Note 
that you can only append data to empty cells.

Select Include headers to export the table header row together with the data.

For parameters export select Separate units column to save the parameter values and 
units in separate columns.

Click Save to save to export the data. Excel automatically starts in the background, if 
available. Excel will close after the export has been performed.

Supported Formats

The format of the data to be imported or exported depends on the model definition 
that you are working with. It is recommended that you export a table to a file to check 
how the data is formatted, you can then format data similarly for the import.

The following is an overview of the data format for each feature that supports reading 
or writing of Excel files:

• Parameters: the first column in the cell range defines the parameter name, the 
second its expression, and the third optional column the parameter description.

The parameter unit can also define the file with an extra column included between 
the expression and the parameter description. For these data formats you need to 
select Separate units column in the Excel load dialog box.
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• Variables: the first column in the cell range defines the parameter name, the second 
its expression, and the third optional column the parameter description. 

• Interpolation functions: the first cell column in the cell range defines the value of the 
input argument parameter t, and the second column defines the value of the 
function f(t).

• Piecewise functions: the first column in the cell range defines the start of the interval, 
the second column defines the end of the interval, and the third column defines the 
expression for the function.

• Parametric Sweep and Auxiliary Sweep: the first column in the cell range defines the 
parameter name, and the second column contains the list of the parameters 
separated by space.

Exchange Workbook Using the COMSOL® API

The COMSOL API provides commands to exchange file with the model, set the 
filename including the Excel extension (.XLSX) to specify workbook.

See the COMSOL Multiphysics Programming Reference Manual for 
the following feature:

• model.param() and model.result().param()

• model.variable()

• model.func()
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In the case the client/server connection such as using COMSOL with MATLAB, the 
Excel file is available on the client machine.

I M P O R T I N G  W O R K B O O K  U S I N G  T H E  C O M S O L  A P I

To load an Excel file type:

model.feat.loadFile(<filename>, "sheet", <range>);

where <filename> is the Excel filename including the .XLSX extension. <range> is 
the top left cell range from which to import the data.

E X P O R T I N G  W O R K B O O K  U S I N G  T H E  C O M S O L  A P I

To save an Excel file type:

model.feat.saveFile(<filename>,"sheet",<range>,header,overwrite);

where <filename> is the Excel filename including the .XLSX extension. <range> is 
the top left cell range to which saving the data. header is a boolean you set to true to 
include the table header and false to not include the table header. overwrite is a 
boolean you set to true to overwrite non-empty cells without warning and false to 
not overwrite non-empty cells without warning.

Exchange Workbook in the Application Builder

LiveLink™ also supports workbook exchange with the model in the Application 
Builder using either a Table form object or dedicated Language Elements.

E X C H A N G E  W O R K B O O K  U S I N G  A  T A B L E  F O R M  O B J E C T

In the Application Builder you can add a Table form object with the Load from file 
and/or Save to file toolbars. 

See Table section in the COMSOL Multiphysics Application Builder 
Reference Manual. 
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When running the application to load data from an Excel workbook click Load from 

file button and select Microsoft Excel Workbook (*.xlsx) as File format. Once you have 
selected the file to import, the Excel Load window pops-up.

This is where you specify the worksheet and range where to import the data. In the 
Range edit field enter the top left cell number or the cell range to load only the specified 
data within the cell range.

Clear Overwrite if you want to keep the data in the current table.

Click Load to import the table.

To save the data available in the table, click Save to file button and select Microsoft 
Excel Workbook (*.xlsx) as File format. Once you have selected the file where to save, 
the Excel Save window pops-up.

This is where you specify the worksheet and range where to export the data. In the 
Range edit field enter the top left cell number or the cell range to save only the data 
that fit the specified cell range.

Clear Overwrite if you want to keep the non-empty cell in the file.

Select Include header if you want also to include the table header in the workbook.

Click Save to export the table.

E X C H A N G E  W O R K B O O K  U S I N G  T H E  M E T H O D  E D I T O R

LiveLink™ offers specific language elements in the Application Builder to exchange 
data between the application and an Excel workbook. These are writeExcelFile and 
readExcelFile to write to an Excel file, and read the data from an Excel file 
respectively.



66 |  C H A P T E R  3 :  L O A D I N G  A N D  S A V I N G  W O R K B O O K  F I L E S

Using the method editor the file you are working can also be available on the server.

You will find below the commands to exchange data with an Excel workbook using the 
method editor available in the Application Builder.

writeExcelFile(String filename, String[][] data)  

Writes the given string data to the first cell onwards in the first sheet of an Excel-file. 

writeExcelFile(String filenname, String sheet, String cell, 
String[][] data)   

Writes the given string data to the specified cell onwards on the specified sheet of an 
Excel-file. 

String[][] readExcelFile(String filename)  

Reads from the first cell onwards on the first sheet of an Excel-file into a String[][].

String[][] readExcelFile(String filename, String sheet, 
String cell)  

Reads from the specified cell onwards on the specified sheet of an Excel-file into a 
String[][].

See File Schemes and File Handling section in the COMSOL 
Multiphysics Application Builder Reference Manual. 

See the application example Beam Section Calculator (using LiveLink for 
Excel) in the LiveLink for Excel Application library. 
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U s i n g  V i s u a l  B a s i c ®  f o r  A p p l i c a t i o n s

LiveLink™ for Excel® supports Microsoft® Excel® built-in language, Visual Basic® 
for Applications (VBA), to access and modify the COMSOL model directly from a 
worksheet. Using Visual Basic for Application makes it possible to control the 
content of Excel workbooks, create user interfaces, and perform advanced 
calculations.

In this chapter:

• Introduction

• Working With Models Using VBA

• Prerequisites

• Object and Methods
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I n t r o du c t i o n

In this section:

• Support for VBA

• Introductory Example

Support for VBA

Visual Basic for Applications (VBA) is a macro language that is built in to Excel. This 
language makes it possible to control the content of workbooks, create user interfaces 
and perform advanced calculations. Using LiveLink™ for Excel® it is also possible to 
connect from Excel to COMSOL and access all the features of the COMSOL 
Application Programming Interface (API). 

The interface based on VBA is using the model structure and the methods 
(commands) for accessing the model settings and data provided by the COMSOL API, 
which programming syntax is similar. You can refer to the COMSOL Programming 
Reference Manual for more information. 

The following parts of the documentation show the steps necessary to work with 
COMSOL models starting with a very simple example based on an existing model..

The LiveLink™ for Excel® User’s Guide Manual assumes that you have 
some knowledge of VBA.

If you run the COMSOL API for use with VBA provided by LiveLink™, 
you cannot use the link between the worksheet and the model defined 
with a cell comment generated by the COMSOL tab.

See Saving the Model File for VBA to learn quickly the COMSOL 
API for use with VBA.
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Introductory Example

Here is a small example that illustrates some of the possibilities that exist for using VBA 
for working with a COMSOL model. The examples requires that LiveLink™ for Excel® 
is properly installed and configured. Some knowledges in VBA are requested to get 
started; these are listed under Prerequisites

To load or create a COMSOL model it is necessary to use the class ModelUtil, which 
is part of the COMSOL API. In addition to ModelUtil, there is a new object that is 
part of LiveLink™ for Excel®, which is called ComsolUtil. This object provides extra 
utilities that are not already present in ModelUtil, such as the ability to start a 
COMSOL Multiphysics Server.

The example loads the busbar model from the Applications Libraries, creates a plot and 
extracts some numerical data and puts the data into an Excel sheet. Below is a detailed 
explanation of the different operation performed by the subroutine. At the end of the 
description you will find the code used for this example, see The Complete VBA Code. 
Copy and paste it in the VBA editor at your convenience.

The example assume that the current worksheet in Excel contains the data as shown as 
in the figure.

1 Start the subroutine:

Sub Example()

2 Create a ComsolUtil object:

Set comsolutil = CreateObject("comsolcom.comsolutil")

3 Start a COMSOL Multiphysics Server with the graphics mode:

Call comsolutil.StartComsolServer(True)

4 Create a ModelUtil object:

Set modelutil = CreateObject("comsolcom.modelutil")

5 Connect to the COMSOL Multiphysics Server that was just opened
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Call modelutil.Connect

6 Load the model file busbar.mph from the COMSOL Multiphysics Applications 
Libraries

Call modelutil.serverDisplay("Loading busbar model")
Set model = modelutil.Load("Model", 
"<COMSOLDIR>\COMSOL_Multiphysics\Multiphysics\busbar.mph")
Call modelutil.serverDisplay("Busbar model is loaded")

where <COMSOLDIR> is your COMSOL Multiphysics installation directory. The call to 
modelutil.serverDisplay displays a message in the COMSOL Multiphysics Server 
window. This help to know which models are loaded on the COMSOL Multiphysics 
Server.

7 Display the plot defined in the group pg1

model.get_result("pg1").Run

The plot is made by the COMSOL Multiphysics Server in a separate window.

8 Collect the coordinate values from the Excel worksheet

Values = Range("A2:C10").Value

The Values variable is a 2D matrix. Note that this is a Nx3 array, which by default starts 
its indexing at 1. In the COMSOL model coordinates have to be entered as a 3xN 
array. Also array indexing always start at 0. 

9 Reformat the data collected in the worksheet in a usable way for the COMSOL 
model

Dim coords() As Double
ReDim coords(0 To 2, 0 To 8)
coords = comsolutil.ConvertToDoubleMatrix(Values, True)

10 Extract the temperature from the model using interpolation coordinates 

Set num = model.result().numerical().Create("interp", "Interp")
Call num.setInterpolationCoordinates(coords)
Call num.set("expr", "T")
res = num.getReal

The above code creates an Interp feature, which handles the extraction of numerical 
data from the model at arbitrary coordinates. The coordinates are specified using the 
method setInterpolationCoordinates. The expression to evaluate is T (temperature). 
Calling the method getReal extracts the actual data form the model and put the data 
in the res variable. The variable res is a 1D array.

11 Insert the temperatures into the Excel sheet

Range("e2:e10").Value = res
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12 Disconnect from the COMSOL server

modelutil.Disconnect
End Sub

If no other clients are connected to the server, the COMSOL Multiphysics Server will 
close automatically.

T H E  C O M P L E T E  V B A  C O D E

Below you find the full script of the example. You can copy it and paste it into the VBA 
editor. In the code below replace <COMSOLPATH> with your local COMSOL 
Multiphysics installation directory.

Sub Example()

Set comsolutil = CreateObject("comsolcom.comsolutil")
Call comsolutil.StartComsolServer(True)

Set modelutil = CreateObject("comsolcom.modelutil")

Call modelutil.Connect

Call modelutil.serverDisplay("Loading busbar model")
Set model = modelutil.Load("Model", 
"<COMSOLPATH>\COMSOL_Multiphysics\Multiphysics\busbar.mph")
Call modelutil.serverDisplay("Busbar model is loaded")

model.get_result("pg1").Run

Values = Range("A2:C10").Value

Dim coords() As Double
ReDim coords(0 To 2, 0 To 8)
coords = comsolutil.ConvertToDoubleMatrix(Values, True)

Set num = model.result().numerical().Create("interp", "Interp")
Call num.setInterpolationCoordinates(coords)
Call num.set("expr", "T")
res = num.getReal

Range("e2:e10").Value = res

modelutil.Disconnect
End Sub
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Work i n g  W i t h  Mode l s  U s i n g  VBA

In this section:

• Saving the Model File for VBA

• Important Notes About the Model Object

• The Model Object Methods

• ComsolCom Version Control

• Declaring ComsolUtil and ModelUtil with Dim

• Error Handling

• Starting and Connecting to a COMSOL Multiphysics Server

• Updating and Solving a Model Using Excel® Macros

Saving the Model File for VBA

You can save the COMSOL model as a file for VBA ready to use in an Excel ® macro. 
In the COMSOL Desktop go to File menu, choose Save As, and, in the Save As window, 
from the Save as type list select Model File for VBA (*.vba).

The commands for each operations on the model are listed in the file in the order of 
they were performed, this way it is easy to get the corresponding command for a 
specific operation as it is the last one in the file.

If you do not want to save the entire model history and save only the commands that 
correspond to the current status model, in the File menu click Compact History prior 
to saving the model.

Important Notes About the Model Object

Consider the following information regarding the model object:

• All algorithms and data structures for the model are integrated in the model object.
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• The model object is used by the COMSOL Desktop to represent your model. This 
means that the model object and the COMSOL Desktop behavior are virtually 
identical.

• The model object includes methods to set up and run sequences of operations to 
create geometry, meshes, and to solve your model.

The Model Object Methods

The model object has a large number of methods. The methods are structured in a 
tree-like way, similar to the nodes in the model tree in the Model Builder window on 
the COMSOL Desktop. The top-level methods just return references that support 
further methods. At a certain level the methods perform actions, such as adding data 
to the model object, performing computations, or returning data.

ComsolCom Version Control

It is possible to manually specify which ComsolCom version to run. To create a 
ComsolUtil and a ModelUtil object from a specific COMSOL version use the 
commands below:

Set comsolutil = CreateObject("comsolcom.comsolutil.<version>")
Set modelutil = CreateObject("comsolcom.modelutil.<version>")

where <version> is the COMSOL version number, for instance 55 for the current 
version.

Once you have set a COMSOL version to use, make sure LiveLink is installed with this 
version number. 

If you don’t want to specify the version number and use the highest COMSOL version 
available, use the commands below:

Set comsolutil = CreateObject("comsolcom.comsolutil")

The Model Object in the COMSOL Multiphysics Programming 
Reference Manual.

Detailed documentation about model object methods is in About 
General Commands in the COMSOL Multiphysics Programming 
Reference Manual.
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Set modelutil = CreateObject("comsolcom.modelutil")

Declaring ComsolUtil and ModelUtil with Dim

It is possible to declare variables of the ComsolUtil and ModelUtil types using Dim, 
to proceed enter the command below:

Dim comsolutil As ComsolCom.comsolutil
Set comsolutil = CreateObject("comsolcom.comsolutil)
Dim modelutil As ComsolCom.modelutil
Set modelutil = CreateObject("comsolcom.modelutil)

To be able to run the code you need to activate the ComsolCom references as static 
reference. To proceed go to Tools menu and click References. In the Available References 
list select ComsolCom 5.5 and click OK.

Error Handling

When working with script it can be useful to trap any errors that either originate from 
COMSOL or from your own code. The VBA editor has some settings that makes it 
possible to trap error in different ways, these tools are available in the Options window. 
The Options window is accessible from the Tools menu of the VBA editor. 

In the Options menu you define the error handling settings in the General page, in the 
Error Trapping section you find:

• Break on All Errors: breaks code execution whenever there is an error. Shows a VBA 
dialog box with the error message.

• Break on Class Module: stops at the actual error (line of code) when a class module 
has been written in VBA.

• Break on Unhandled Errors: breaks code execution whenever there is an error but 
also allows you to trap the error (using the On Error statement). If you fail to trap 
an error you will get a dialog box from VBA.

E X A M P L E

In the VBA editor enter the code below. The code starts a COMSOL Multiphysics 
Server and connects it with Excel. Finally it tries to load a model MPH-file that does 
not exist, as it is meant to fail.

Set comsolutil = CreateObject("comsolcom.comsolutil")
Call comsolutil.StartComsolServer(True)

Set modelutil = CreateObject("comsolcom.modelutil")
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Call modelutil.Connect

Set model = modelutil.Load("Model", "c:\\foo.mph")

End Sub

Assuming that the file foo.mph does not exists and if the error trapping is set to Break 
on All Error, the following error message is returned:

Run-time error ‘-2146233088 (80131500’):
java.lang.IllegalStateException: java.io.FileNotFoundException: 
C:\foo.mph (The system cannot find the file specified)

The numbers do not have any useful meaning, but sometimes you are able to decipher 
the message in the window. In this case the message says something about The system 
cannot find the file specified, which is expected. Click the End button to stop 
the VBA code from running.

When writing your own code you may want to be able to handle errors differently so 
that you can show a nice dialog box about the problem or perhaps fix the problem on 
the fly. This is especially useful if you write code that other people will use. The On 
Error statement allow you to handle any error that may occur.

Update the code above such as:

Sub loadfile_error()

On Error GoTo errorhandler

Set comsolutil = CreateObject("comsolcom.comsolutil")
Call comsolutil.StartComsolServer(True)

Set modelutil = CreateObject("comsolcom.modelutil")
Call modelutil.Connect

Set model = modelutil.Load("Model", "c:\\foo.mph")

Exit Sub

errorhandler:
Call MsgBox("Error: " + Err.Description)
End Sub

Make sure the Error trapping option is set to Break on Unhandled Errors and run the 
script. You will now get the following message:

Error: java.lang.IllegalStateException: 
java.io.FileNotFoundException: C:\foo.mph (The system cammot find 
the file specified)
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In this example we are just showing an error message and an OK button. For more 
advanced error handling you may want to customize the error message further and 
provide different options to the user.

Starting and Connecting to a COMSOL Multiphysics Server

LiveLink™ for Excel® provides methods for starting and connecting to a COMSOL 
Multiphysics Server.

Ordinarily one would execute this command to start the COMSOL Multiphysics 
Server:

comsolutil.StartComsolServer(True)

This command will start the COMSOL Multiphysics Server in graphics mode on the 
local computer. A port number, that is used for the communication between the 
COMSOL server and Excel, is automatically assigned by the COMSOL server. The 
default number is 2036, but if other COMSOL servers are running then a higher 
number has to be chosen. 

The method StartComsolServer also returns a boolean to indicate if the COMSOL 
server has started (True) or failed to start (False).

To connect Excel to the COMSOL server using the default port number you simply 
use the command:

Call modelutil.Connect

Its is also possible to specify the machine host where the COMSOL server is running 
and the port number is listening to. The example below show how to start the 
COMSOL server and set the connection in a reliable way:

ok = comsolutil.StartComsolServer(True)

' Test for a proper start and give an error message if something 
failed.
If ok = False Then
MsgBox "no server " & comsolutil.get_errormessage
Exit Sub
End If

Running a script without the On Error statement but with the Error 
trapping option set to Break on Unhandled Errors may return message 
without sufficient information.
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' Get the port number used
port = comsolutil.get_port

' Connect to the server using the specified port number
Set modelutil = CreateObject("comsolcom.modelutil")
Call modelutil.Connect("localhost", port)

Updating and Solving a Model Using Excel® Macros

In this section you will find several examples that illustrate some of the possibilities that 
exist for using VBA for working with a COMSOL model. 

The current example reuses the worksheet described in the section Working with 
COMSOL® Models in Excel® in the Introduction to LiveLink™ for Excel® 
manual. The steps below shows how to write commands that automatically update the 
model with the settings in the worksheet, compute the solution and update the results 
data extracted in the worksheet.

When writing a subroutine in VBA the cell comment generated using the COMSOL 
toolbar are not usable. Enter the full command using the COMSOL API to reproduce 
the same behavior.

The full model example consists of several examples that will show you the different 
capabilities of the COMSOL API used together with VBA such as:

• Connecting the Model

• Updating Parameters and Computing the Solution

• Extracting Data

If you decide to not follow the example in order of appearance, you can use the 
commands provided at the end of each example where all the code is summarized.

To get ready with the examples follow the steps below.

1 Start Excel, in the File tab, click Open.

2 In your COMSOL Multiphysics installation directory, find the folder 
models/LiveLink_for_Excel/Tutorials. 

Some knowledge in VBA are required to run the example. For more 
information please refer to the section Prerequisites.
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3 Select the file busbar_llexcel.xlsx and click the Open button.

You can see in cell range B2, the full name of the model MPH-file that is linked to the 
workbook. In the first worksheet you can assign value to model parameters and 
parameters sweep. It also contains the value of the maximum temperature in the busbar 
for the different parameter sweep values. The second worksheet contains the joule 
heating data interpolated at point coordinates defined in cell range A3 to C20.

4 Go to the Excel File menu and select COMSOL. In the COMSOL backstage view click 
Open button  and select Open linked .

Note: If your COMSOL installation folder is the same than the one described in the 
filename in B1, the application is automatically loaded, else you need to specify the 
location. Find the folder applications/LiveLink_for_Excel/Tutorials. Select 
the file busbar_llexcel.mph and click the Open button.

The COMSOL Multiphysics Server starts and loads the model file busbar_llexcel.mph 
that is linked to the worksheet.

5 In Excel press Alt+F11 keys to open the VBA editor.

6 In the VBA editor, go to Insert menu and select Module.

7 In the editor type:

Sub busbarUpdate()

and press Enter key to get the end subroutine line automatically added to the script.
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To run the macro a convenient way is to create a button. To proceed you need first to 
enable the Developer tab in the Excel ribbon.

8 In Excel, go to the File tab and select Options.

9 In the Excel Options window, select Customize Ribbon and on the right side of the 
window under Main Tabs select Developer. 

10 Click OK.

11 Go to the Developer tab and click Insert. 

12 Under Form Controls select Button (Form Control) and draw the button in the 
worksheet.

13 In the Assign Macro window that just pops-up, under the Macro name list select 
busbarUpdate. Click OK.
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14 You now have a button in the worksheet that runs the macro you will write in the 
example below. You can remove the inserted image and change the text in the 
button so that the worksheet looks like in the image below..

C O N N E C T I N G  T H E  M O D E L

The first example consists of writing the commands to load the required objects, 
connect to the model and run a basic command such a plotting a result in a graphics 
window.

In order to work with a COMSOL model it is necessary to use the class ModelUtil, 
which is part of the COMSOL API. In addition to ModelUtil there is a new object 
that is part of LiveLink™ for Excel®, which is called ComsolUtil. This object provides 
extra utilities - such as the ability to start a COMSOL Multiphysics Server.

Type the command at the line after the subroutine declaration line Sub 
updateBusbar().

1 Load the COMSOLUtil and the ModelUtil objects.

Set comsolutil = CreateObject("comsolcom.comsolutil")
Set modelutil = CreateObject("comsolcom.modelutil")

2 To allow long running jobs enter the command:

The worksheet including the full example code is available at 
XLSM-format in the LiveLink™ for Excel® Applications Libraries 
LiveLink_for_Excel/Tutorials/busbar_llexcel.xlsm
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Call comsolutil.TimeOuthandler(true)

The COMSOL Multiphysics Server is already started and a COMSOL model with the 
tag Model is loaded when clicking Open on the COMSOL toolbar as described in 
Updating and Solving a Model Using Excel® Macros. 

3 Connect the COMSOL server.

Call modelutil.Connect

4 Set a link with the model, with the tag Model, available on the COMSOL server.

Set model = modelutil.model("Model")

5 Display the second plot group.

Call model.get_result("pg2").Run

6 Disconnect the COMSOL server.

Call modelutil.Disconnect

7 Press F5 key to run the subroutine.

Below you find the complete VBA code; feel free to copy and paste it to the VBA 
editor.

Sub busbarUpdate()

Set comsolutil = CreateObject("comsolcom.comsolutil")
Set modelutil = CreateObject("comsolcom.modelutil")

Call comsolutil.TimeOuthandler(true)

Call modelutil.Connect

Set model = modelutil.model("Model")

Call model.get_result("pg2").Run

Call modelutil.Disconnect

End Sub

An alternative is to start the COMSOL Multiphysics Server and load the 
model using COMSOL API commands. For more information, see the 
section Starting and Connecting to a COMSOL Multiphysics Server.
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U P D A T I N G  P A R A M E T E R S  A N D  C O M P U T I N G  T H E  S O L U T I O N

The cell range A5 to D5 define both the value and the unit for the model parameter 
extern_L. Continue to edit the Sub started in the example above just after the line 
Set model = modelutil.model("Model").

1 To Set the value defined in the cell range B5 to the model parameter extern_L enter:

para1_name = Sheets("Sheet1").Range("A5").Value
para1_value = Sheets("Sheet1").Range("B5").Value
para1_unit = Sheets("Sheet1").Range("C5").Value
para1 = Str(para1_value) & "[" & para1_unit & "]"
Call model.param.set(para1_name, para1)

It is not necessary to set the parameter extern_Vtot with the value in cell range 
A6:C6 as the parameter is also defined as auxiliary sweep parameter.

The worksheet contains values for the busbar width (wbb) and the applied voltage 
(extern_Vtot) as sweep parameter. 

2 To set the value defined in cell range B9:D9 to the parametric sweep parameter wbb 
enter:

wbbValue = Sheets("Sheet1").Range("B9:D9").Value
Dim wbbInput() As Double
wbbInput = comsolutil.ConvertToDoubleMatrixDecimal(wbbValue, 
False, ".")
Call model.get_study("std1").get_feature("param").set("plistarr", 
wbbInput)

3 Now set the applied voltage values:

Vtot = Sheets("Sheet1").Range("B10").Value
Call model.get_study("std1").get_feature("stat").set("plistarr", 
Vtot)

4 To enable the progress bar and compute enter:

Call modelutil.ShowProgress(True)
Call model.get_study("std1").Run

5 Press F5 to run the Sub.

Below you find the complete VBA code; feel free to copy and paste it to the VBA 
editor.

Sub busbarUpdate()

Set comsolutil = CreateObject("comsolcom.comsolutil")
Set modelutil = CreateObject("comsolcom.modelutil")

Call comsolutil.TimeOuthandler(true)
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Call modelutil.Connect

Set model = modelutil.model("Model")

para1_name = Sheets("Sheet1").Range("A5").Value
para1_value = Sheets("Sheet1").Range("B5").Value
para1_unit = Sheets("Sheet1").Range("C5").Value
para1 = Str(para1_value) & "[" & para1_unit & "]"
Call model.param.set(para1_name, para1)

wbbValue = Sheets("Sheet1").Range("B9:D9").Value
Dim wbbInput() As Double
wbbInput = comsolutil.ConvertToDoubleMatrixDecimal(wbbValue, False, ".")
Call model.get_study("std1").get_feature("param").set("plistarr", wbbInput)

Vtot = Sheets("Sheet1").Range("B10").Value
Call model.get_study("std1").get_feature("stat").set("plistarr", Vtot)

Call modelutil.ShowProgress(True)
Call model.get_study("std1").Run

Call model.get_result("pg2").Run

Call modelutil.Disconnect

End Sub

E X T R A C T I N G  D A T A

In this example you learn how to evaluate data in the model and after having extracted 
the data from the model the data is entered in the Excel worksheet. First you will 
implement a point evaluation to get the maximum temperature in the busbar for all 
parameter values computed for. Then you will write the command to interpolate the 
Joule heating value at location coordinates stored in the worksheet.

Start editing the code after the line Call model.get_result("pg2").Run.

1 To create a point numerical evaluation node in the model enter:

Set pev = model.result().numerical().Create("pev", "EvalPoint")

2 Set the evaluation on point 1 to evaluate the maximum temperature in the busbar 
(using the expression maxop1(T)) and use the second solution data set for the 
evaluation:

Dim myNum(0 To 0) As Long
myNum(0) = 1
Call pev.Selection.set(myNum)
Call pev.set("expr", "maxop1(T)")
Call pev.set("data", "dset2")

3 Create a table and store the point evaluation to this table:
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Set tbl = model.result.Table().Create("tblEval", "Table")
Call pev.set("table", "tblEval")
Call pev.setResult

4 Get the table header and table data and set the value in the worksheet:

Sheets("Sheet1").Range("H4:J4").Value = tbl.getColumnHeaders
Sheets("Sheet1").Range("H5:J19").Value = tbl.getTableData(0)
For i = 1 To 3

For j = 1 To 15
Sheets("Sheet1").Range("H5").Offset(j - 1, i - 1) = _
Val(Sheets("Sheet1").Range("H5").Offset((j - 1), (i - 1)))

Next
Next

5 Remove the point evaluation and the table from the model:

Call model.result().numerical().Remove("pev")
Call model.result().Table().Remove("tblEval")

Now you add an interpolation node to extract the value of an expression at arbitrary 
location.

6 Get the interpolation coordinates stored in the worksheet:

Dim coords() As Double
Values = Sheets("Sheet2").Range("A3:C20").Value
coords = comsolutil.ConvertToDoubleMatrixDecimal(Values, True, 
".")

7 Create an interpolation node:

Set interp = model.result().numerical().Create("interp", "Interp")

8 Set the interpolation node with interpolation coordinates, the expression to evaluate 
(ht.Qtot) and the solution data set to use:

Call interp.setInterpolationCoordinates(coords)
Call interp.set("expr", "ht.Qtot")
Call interp.set("data", "dset2")

9 For each outer solution extract the interpolation data and set the results in the 
worksheet after reformatting:

For i = 1 To 3
Call interp.set("outersolnum", i)
resInterp = interp.GetData(0)
resInterp2 = Application.WorksheetFunction.Transpose(resInterp)

The table returns the data as a string array, this is why some manual 
reformatting is necessary in order to get value in the worksheet.
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M = UBound(resInterp2, 1) - LBound(resInterp2, 1) + 1
N = UBound(resInterp2, 2) - LBound(resInterp2, 2) + 1
Sheets("Sheet2").Range("D3").Offset(0,(i-1)*N).Resize(M,N) = _
resInterp2

Next

10 Remove the interpolation node:

Call model.result().numerical().Remove("interp")

11 Press F5 key to run the Sub.

Below you find the complete VBA code, feel free to copy and paste it to the VBA editor

Sub busbarUpdate()

Set comsolutil = CreateObject("comsolcom.comsolutil")
Set modelutil = CreateObject("comsolcom.modelutil")

Call comsolutil.TimeOuthandler(true)

Call modelutil.Connect

Set model = modelutil.model("Model")

wbbValue = Sheets("Sheet1").Range("B9:D9").Value
Dim wbbInput() As Double
wbbInput = comsolutil.ConvertToDoubleMatrixDecimal(wbbValue, False, ".")
Call model.get_study("std1").get_feature("param").set("plistarr", wbbInput)

Vtot = Sheets("Sheet1").Range("B10").Value
Call model.get_study("std1").get_feature("stat").set("plistarr", Vtot)

Call modelutil.ShowProgress(True)
Call model.get_study("std1").Run

Call model.get_result("pg2").Run

Set pev = model.result().numerical().Create("pev", "EvalPoint")

Dim myNum(0 To 0) As Long
myNum(0) = 1
Call pev.Selection.set(myNum)
Call pev.set("expr", "maxop1(T)")
Call pev.set("data", "dset2")

Set tbl = model.result.Table().Create("tblEval", "Table")
Call pev.set("table", "tblEval")
Call pev.setResult

Sheets("Sheet1").Range("H4:J4").Value = tbl.getColumnHeaders
Sheets("Sheet1").Range("H5:J19").Value = tbl.getTableData(0)
For i = 1 To 3

For j = 1 To 15
Sheets("Sheet1").Range("H5").Offset(j-1, i-1) = _ 
Val(Sheets("Sheet1").Range("H5").Offset((j-1), (i-1)))
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Next
Next

Call model.result().numerical().Remove("pev")
Call model.result().Table().Remove("tblEval")

Dim coords() As Double
Values = Sheets("Sheet2").Range("A3:C20").Value
coords = comsolutil.ConvertToDoubleMatrixDecimal(Values, True, ".")

Set interp = model.result().numerical().Create("interp", "Interp")

Call interp.setInterpolationCoordinates(coords)
Call interp.set("expr", "ht.Qtot")
Call interp.set("data", "dset2")

For i = 1 To 3
Call interp.set("outersolnum", i)
resInterp = interp.GetData(0)
resInterp2 = Application.WorksheetFunction.Transpose(resInterp)
M = UBound(resInterp2, 1) - LBound(resInterp2, 1) + 1
N = UBound(resInterp2, 2) - LBound(resInterp2, 2) + 1
Sheets("Sheet2").Range("D3").Offset(0, (i-1)* N).Resize(M,N) = resInterp2

Next

Call model.result().numerical().Remove("interp")

Call modelutil.Disconnect

End Sub
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P r e r e qu i s i t e s

In this chapter you find the minimum you need to know in Visual Basic for Application 
(VBA) in order to run macro using LiveLink™ for Excel®. 

In this section:

• Enabling the Developer Toolbar

• Manual Installation

• Saving Excel Workbooks Containing Macros

Enabling the Developer Toolbar

VBA is installed with Excel, and the VBA editor is accessible just by pressing Alt+F11 
keys within Excel. To run the subroutine directly from the worksheet you need to 
enable the Developer toolbar in the Excel ribbon. In the Developer toolbar you will 
find the different control tools that can be inserted in the worksheet.

The steps below describe how to activate the Developer toolbar in the Excel ribbon.

1 In Excel right-click on any tab of the ribbon and select Customize the Ribbon....

2 In the Excel Options window, locate the Main Tabs list and select Developer. 

3 Click OK.

The Developer tab is now available in the ribbon.

Manual Installation

When installing LiveLink™ the component necessary for supporting VBA is installed 
as well. For manual control, it is possible to manually register and unregister the 
ComsolCom.dll component.

R E G I S T E R  T H E  V B A  S U P P O R T  C O M P O N E N T

In order to register the VBA component you must open a Command Prompt as 
Administrator and execute the following command:

This section is not intended to provide information about VBA but how 
to run a script in VBA using LiveLink™ for Excel®.
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C:\Windows\Microsoft.NET\Framework\v4.0.30319\RegAsm.exe 
"<COMSOLPATH>\ext\LiveLink\Excel\<arch>\comsolcom.dll" /codebase 
/tlb

where <COMSOLPATH> is your COMSOL Multiphysics installation directory path and 
<arch> is the Excel architecture type (win32 or win64 for Excel 32-bits or Excel 
64-bits respectively).

U N R E G I S T E R  T H E  V B A  S U P P O R T  C O M P O N E N T

In order to unregister the VBA component you must open a Command Prompt as 
Administrator and execute the following command:

C:\Windows\Microsoft.NET\Framework\v4.0.30319\RegAsm.exe 
"<COMSOLPATH>\ext\LiveLink\Excel\<arch>\comsolcom.dll" /u /tlb

where <COMSOLPATH> is your COMSOL Multiphysics installation directory path and 
<arch> is the Excel architecture type (win32 or win64 for Excel 32-bits or Excel 
64-bits respectively).

Saving Excel Workbooks Containing Macros

If you have an Excel workbook that contains VBA code (or macros) you need to save 
it as an Excel Macro-Enabled Workbook, which has the “.xlsm” extension.

Depending on your security settings for your computer as well as the security settings 
for Microsoft Office you may receive a warning when opening an Excel XLSM-file.
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Ob j e c t  and Me t hod s

The interface based on VBA is using the same structure of the model and the same 
methods for accessing the model settings and data. Most of the COMSOL API 
method are available in VBA, some of them had to be renamed in order to fulfilled the 
Component Object Model (COM) technology requirements. LiveLink™ for Excel® 
also provides a utility class, ComsolUtil, that is useful for specific operation between a 
COMSOL model and Excel worksheet.

In this section:

• The COMSOL® API

• Renamed Method

• ComsolUtil

The COMSOL® API

COMSOL provides an API based on Java that makes it possible to access COMSOL 
models settings and results. The COMSOL API consists on approximately 200 classes. 
These classes contain many methods each. All these methods are covered in the 
COMSOL Programming Reference Manual.

A D A P T I N G  C O M S O L  A P I  C O D E  I N  V B A

The COMSOL Desktop supports saving model as JAVA-file, this make it very 
convenient to learn the COMSOL API syntax. However the code generated in the 
JAVA-file requires some adaption to be run in VBA. The difference between the code 
to be used with JAVA and with VBA consist in:

• Methods with the same name resulting in different operation has to be renamed, see 
the section Renamed Method

• The keyword Call has to be used on every lines that call a method in the COMSOL 
API when the method do not return anything.

• The set method, in the COMSOL API, does return a reference to the object being 
changed. In VBA it does not returning anything.

• Methods that involve three- or four-dimensional arrays are not supported in VBA. 
These methods are faceDDX, faceDX, faceFF1, and faceFF2.
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The COMSOL API may change over time. Adding new methods to the COMSOL 
API may result in conflicts with the way that methods are named using COM. Hence 
as methods are adding to the API some method named will get the prefix get_ (or 
other changes will be applied in order to avoid conflicts).

Renamed Method

In the COMSOL API you can have methods with the same name resulting in different 
operation. To adapt the COMSOL API with the COM requirements some methods 
have to be renamed. 

G E T T I N G  A N D  S E T T I N G  P R O P E R T Y

In the COMSOL API you can get and set properties with the same method name. For 
instance the method author() can return the author name of a node in the model 
using the syntax:

String author()

But it can also set the author name of the node in the model using the syntax:

ModelEntity author(String name)

As a standard, the methods used for getting the value of a property is renamed with 
the prefix “get_”. The methods used for setting the value of a property are left with 
their name in the COMSOL API.

In the above example to run the first method in VBA you need to type:

string get_author()

While to run the second one, the same syntax is used:

ModelEntity author(string name)

Some of the method that requires name change depending on either they set or get 
properties are listed below:

string tag();
string label();
string comments();
String author();
string version();
string model();
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R E T R I E V I N G  N O D E S  I N  T H E  M O D E L

For working with the structure of the model tree there are a number of methods that 
are used to retrieve nodes. These methods also exist in two version with the same name 
here exemplified using the study method.

The COMSOL API syntax to return a list that contains all the studies in the model is 
the following:

StudyList study()

In case you have several studies in the model, you can return a particular study from 
the list of available studies. In the COMSOL API the syntax is:

Study study(String tag)

Is it customary in COM to denote the latter using a prefix “get_” to indicate that a 
single entry of a list is requested, while the first method keep the same name as in the 
COMSOL API. 

In the above example to run the first method in VBA you need to type:

StudyList study()

While to run the second one, the same syntax is used:

Study get_study(String tag)

As a specific example, to set the selection of the mesh size node to a point in the 
COMSOL API you enter:

model.mesh("mesh").feature("size").Selection.geom("geom",0)

while to run the same in VBA you need to change the command to the following one:

Call model.get_mesh("mesh").get_feature("size").Selection.geom("geom",0)

G E T A D J ( )  A N D  G E T A D J O R I E N T ( )

The method getAdj() returns an array or a vector depending on the number of 
arguments. The method that returns an array is renamed to getAdj1 and the method 
that returns a vector is renamed into getAdj2. 

Similar renaming has been performed in the method called getAdjOrient, the 
method that returns an array is renamed to getAdjOrient1 and the method that 
returns a vector is renamed into getAdjOrient2.
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ComsolUtil

Additionally to the COMSOL API, LiveLink™ for Excel® provides its own object 
comsolutil, which contains the method to handle operation between the COMSOL 
server and Excel.

S Y N T A X

This section describes the specific methods available with LiveLink™ for Excel®.

Set comsolutil = CreateObject("comsolcom.comsolutil")

The commands above make all COMSOL utility methods available using VBA. 

bool StartComsolServer(bool usegraphics) starts a COMSOL Multiphysics 
Server. The boolean usegraphics is true to start the a graphics COMSOL server. The 
method StartComsolServer returns a boolean that indicates if the COMSOL server has 
started successfully or not, the value of the boolean being true or false respectively.

bool isGraphicsServer() returns true if the COMSOL server is started as a 
graphics COMSOL server. The method isGraphicsServer requires an established 
connection to a COMSOL server.

double[,] ConvertToDoubleMatrix(object obj, bool transpose) converts 
the incoming object to an array of doubles in COMSOL API format. The input object 
obj is either a scalar or an array, with the type string, integer (long or short) or double. 
The returned array will have the start index as zero, as it is requested in the COMSOL 
API. If transpose is true then the input array is transposed before the output is 
created.

double[,] ConvertToDoubleMatrixDecimal(object o, bool transpose, 

string dec) converts the incoming object to an array of doubles in COMSOL API 
format. The input object obj is either a scalar or an array, with the type string, integer 
(long or short) or double. The returned array will have the start index as zero, as it is 
requested in the COMSOL API. If transpose is true then the input array is 
transposed before the output is created. In addition this method support the decimal 
sign definition (usually "," or "."). Decimal sign definition is important to specify 
when converting strings to values.

double[] ConvertToDoubleVector(object o) converts the incoming object to an 
vector of doubles. The input matrix may be a scalar or a vector. The input may be of 
the type string, integer (long or short) or double. The returned vector will have the 
start index as zero, which makes it possible to send such vectors to COMSOL when 
vectors have to be supplied as an argument to a method in the COMSOL API. 
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void TimeOuthandler(bool on) if the argument on is true a timeout handler is 
applied to Excel that prevents any timeout when performing long running tasks (such 
as solving large models). Excel (and COM) prevents long running jobs by opening a 
dialog box for statements that take "a long time". Calling 
comsolutil.TimeOutHandler(true) before calling any such statements prevent these 
warning/error messages.

get_version() returns the version of the ComsolCom interface as a string (for 
example, "5.5.0.0").

get_port() returns the port number of the COMSOL server that has been started 
using StartComsolServer().

get_errormessage() returns any error message that was created by 
StartComsolServer() or other methods in comsolutil.
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I n d e x

A Application Libraries window 14

C COMSOL tab 18

D Definitions group 19

documentation 13

E emailing COMSOL 15

exporting material data 53

I internet resources 13

K knowledge base, COMSOL 16

M material data

exporting 53

Material Export group 30

model object

methods 73

MPH-files 14

N Numerical Results group 24

P Plots group 23

S sequences of operations 73

Study group 22

T technical support, COMSOL 15

V View group 22

W websites, COMSOL 16

worksheets, working with 33
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